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Informations

Documento: MIMC1R44Fx BASE
Description: Installation and maintenance manual
Editor: Riccardo Furlato
Approver Gabriele Bazzi
Link: http://www.qem.eu/doku/doku.php/en:strumenti/qmoveplus/C1R44/mimC1R44fx_base
Language: English
Document release Hardware Release Description Note Date

01 01 New manual / 19/02/2015
02 01 Fixes / 07/04/2015
03 01 Fixes description DIP-SW4 / 01/07/2015
04 01 Fixes the description of the analog input connector CN13 / 24/08/2015
05 01 Added new section “General information of operation” / 13/01/2016

06 01 Fixes the description of the setting of the analogue inputs
and related connection examples / 01/02/2015

07 01 New “FE” version and connection between the expansion
card “1MG2F” / 16/05/2016

08 01 Fixed the description of connectors CN14-17, for
frequency meter inputs / 05/09/2016

The controller has been designed for industral environments in conformity to EC directive 2004/108/CE.

EN 61000-6-4: Electromagnetic compatibility - Generic standard on emission for industrial environments
EN55011 Class A: Limits and measurement methods
EN 61000-6-2: Electromagnetic compatibility - Generic standard on immunity for industrial environments

EN 61000-4-2: Electromagnetic compatibility - Electrostatic discharge immunity
EN 61000-4-3: Immunity to radiated, radio-frequency electromagnetic field
EN 61000-4-4: Electrical fast transients
EN 61000-4-5: Surge immunity
EN 61000-4-6: Conducted disturbance induced by radio-frequency
Moreover the product is conform to the following standards:

EN 60529: Housing protection rating IP64
EN 60068-2-1: Environmental testing: Cold
EN 60068-2-2: Environmental testing: Dry heat
EN 60068-2-14: Environmental testing: Change of temperature
EN 60068-2-30: Environmental testing: Cyclic damp heat
EN 60068-2-6: Environmental testing: Sinusoidal vibration
EN 60068-2-27: Environmental testing: Shock vibration
EN 60068-2-64: Environmental testing: Random vibration

https://wiki.qem.it/lib/exe/fetch.php/varie/logo_qem_documentazione.png
http://www.qem.eu/doku/doku.php/en:strumenti/qmoveplus/C1R44/mimC1R44fx_base
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1. Description

The C1-R44-F is the compact instrument for panel mounting of the Qmove+ range.

1.1 Product identification

The Ordering Code provides the exact product features.
Make sure that the product characteristics meet your requirements.

1.1.1 Product label

a - Ordering Code
b - Week made: indicates the week and year of manufacture
c - Part number: unique code that identifies an ordering code
d - Serial number: product serial number, different for individual product
e - Hardware release: version of hardware release
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1.1.2 Ordering code

Model Features

C1 - R44 - FA - 10

10 = Firmware version (00 = not installed)
F = Technology level
A = Hardware version

R = Rear panel mounting instrument;
4 = Dimensions (251x175mm)
4 = Firmware-hardware correspondence

C1 = “Motion” Qmove family



C1-R44-Fx BASE

7/77

1.1.3 Hardware versions

These are hardware versions currently available:

Hardware versions
A B C E Y

SLOT 2
(Base card)

USER PORT (RS232-422-485) 1 1 1 1 1
AUX PORT (RS485) 1 1 1 1 1
CAN1 PORT 1 1 1 1 1
CAN2 PORT 1) - - - - -
ETHERNET PORT 1 1 1 1 1
USB PORT 1 1 1 1 1
Standard digital inputs 16 16 16 16 16
Rapid digital inputs (can be used as frequency meters) - 2 2 2 2
Analog inputs 16bit selectable(0-10V, 0-20mA, potenziometric,
termocouples, PT100) 2 2 2 2 2

Bidirectional counters 200KHz ABZ (24V-PP, 5V-LD) - 2 4 2 4
SSI counter inputs - - - - 2
Protected digital outputs 16 16 16 16 16
Stepper outputs - - - - 2
Analog outputs +/-10V-16bit - 2 4 2 4

CSoftware code of the card to declare as base card 1QM4F

Expansion
card

Standard digital inputs - - - 16 -
Analog inputs 12bit - - - - -
Analog inputs 16bit seleectable (0-10V, 0-20mA, potenziometric,
termocouples, PT100) - - - - -

Protected digital outputs - - - 16 -
Relay digital outputs - - - - -
Analog outputs 0-10V-12bit - - - - -
Analog outputs +/-10V-16bit - - - - -
Bidirectional counters 200KHz ABZ (24V-PP, 5V-LD) - - - - -

Software code of the card to declare as expansion card - - - 1MG2F -

1.1.4 Expansion cards manuals

1MG2F rel.01

1.1.5 Firmware versions

Version Description
10 Fully programmable with PLC functions
20 Fully programmable with PLC and Motion control functions
30 Fully programmable with PLC, Motion control, Camming and Interpolation functions

For more details about the firmware, consult Devices enabled in the controllers.

https://wiki.qem.it/doku.php/en/strumenti/qmoveplus/mim1mg2f01
https://wiki.qem.it/lib/exe/detail.php/icone/icona_mim-card.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/doku.php/en/software/devices#devices_enabled_in_the_controllers
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1.2 Product Configuration

1.2.1 Back terminal blocks

The C1-R44-F composed of a “base” card and an “expansion” card.

a = Base card
b = Expansion card



C1-R44-Fx BASE

9/77

2. Technical features

2.1 General Features
Weight (maximum hardware configuration) 1.2Kg
Material box Sheet metal
System led 8
System keys 3
Operating temperature 0 ÷ 50°C
Transport and storage temperature -25 ÷ +70 °C
Relative humidity 90% condensate free
Altitude 0 - 2000m s.l.m.
Front panel protection IP20

2.2 CPU (F level technology)
RISC microprocessor (32 bit)
Work frequency 200MHz
RAM 32MB
Flash 16MB
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2.3 Dimensions

Lengths in mm
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2.4 Drilling template
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3. Base card wiring

For details about cable sections and connectors, see application note AN021

.

The electrical features are described in the section Electrical features.
The wiring examples are given in section Connection examples

https://wiki.qem.it/doku.php/en/appnote/an021
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3.1 Power supply

The cabling must be carried out by specialist personnel and fitted with suitable anti-static
precautions.
Before handling the controller, disconnect the power and all parts connected to it.
To guarantee compliance with EC regulations, the power supply must have a galvanic
isolation of at least 1500Vac.

.

Power supply 24 Vdc
Voltage range 22 - 27 Vdc
Max. absorption 10W

Connector

CN1 Terminal Symbol Description

1 DC power positive

2 GROUND Gnd-PE (signals)

3 DC power 0V
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Connection examples

Use an isolated power unit with 24Vdc +/-5% output conform to EN60950-1.

.

Use two separate power units: one for the control
circuit and one for the power circuit

For a single power unit, use two separate lines:
one for the control and one for the power

DO NOT use the same lines for the power circuit
and the controller
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3.2 Serial Port Connections

3.2.1 PROG PORT (USB mini-B)

PROG PORT Description

Serial port used for the transfer and debugging of the application program in the CPU.
Use only with IQ009 or IQ013.

3.2.2 USER PORT

Connector

CN2 Terminal RS232 RS422 RS485 Description
1A - - A Terminal A - RS485
2A - - B Terminal B - RS485
3A 0V 0V 0V USER PORT common
4A 0V 0V 0V USER PORT common
5A TX - - Terminal TX - RS232
6A Ground
1B - RX - Terminal RX - RS422
2B - RXN - Terminal RX N - RS422
3B - TX - Terminal TX - RS422
4B - TXN - Terminal TX N - RS422
5B RX - - Terminal RX - RS232
6B Ground

Setting USER PORT electric standard

SW2 Num.
Dip

Name
DIP

Setting
of DIP Function

1 JP2 ON X2) X3) Termination RS485

2 JP3 ON X4) X5)

Polarisation RS485
3 JP1 ON X6) X7)

4 OFF ON OFF

Selection of USER PORT electric standard5 ON OFF OFF

6 OFF OFF ON

RS485 RS422 RS2328)

1), 3), 4), 5), 6), 7) option not enabled
2) X = setting not significant
8) the USER PORT can be used as PROG PORT with RS232 electric standard, setting ON in DIP-8 of SW1 and OFF in DIP-6 of SW2

https://wiki.qem.it/doku.php/en/strumenti/accessori/iq009
https://wiki.qem.it/doku.php/en/strumenti/accessori/iq013
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3.2.3 AUX PORT

Connector

CN3 Terminal Symbol Description

1 0V RS485 serial common

2 B Terminal RS485 B

3 A Terminal RS485 A

Setup of AUX2 PORT polarisation and termination resistances

SW3 Num.
Dip

Name
Dip

Setting
of DIP Function

1 JP3 ON Polarisation RS485

2 JP2 ON Termination RS485

3 JP1 ON Polarisation RS485

4 X1) None

1) X = setting not significant
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3.2.3.1 CANbus PORT

Connector

CN5
CAN1 PORT Terminal Symbol Description

1 0V CAN common

2 CAN L Terminal CAN L

3 CAN H Terminal CAN H

Termination resistor setting

Name
jumper Setting of DIP Function

JP3 JP4
JP3

INSERTED Termination CAN active

JP4

Connector

CN4
CAN2 PORT Terminal Symbol Description

1 0V CAN common

2 CAN L Terminal CAN L

3 CAN H Terminal CAN H

Termination resistor setting

Name
jumper Setting of DIP Function

JP1 JP2
JP1

INSERTED Termination CAN active

JP2
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3.2.4 ETHERNET port

ETHERNET PORT Description

Connector RJ45.

LED:
* LINK: green led = cable connected (led on signals the cable is connected to both ends)
* DATA: yellow led = data transmission (flashing led signals data transmission)
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3.2.5 MMC/SD

Memory card slot (marked by an arrow)
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3.2.6 USB
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3.3 Digital inputs

3.3.1 16 PNP digital inputs

CN7 Terminal Symbol Description Addres

1 0V Common for digital inputs

2 I1 Input I1 2.INP01

3 I2 Input I2 2.INP02

4 I3 Input I3 2.INP03

5 I4 Input I4 2.INP04

6 I5 Input I5 2.INP05

7 I6 Input I6 2.INP06

8 I7 Input I7 2.INP07

9 I8 Input I8 2.INP08

.

CN6 Terminal Symbol Description Address

1 0V Common for digital inputs

2 I9 Input I9 2.INP09

3 I10 Input I10 2.INP10

4 I11 Input I11 2.INP11

5 I12 Input I12 2.INP12

6 I13 Input I13 2.INP13

7 I14 Input I14 2.INP14

8 I15 Input I15 2.INP15

9 I16 Input I16 2.INP16
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3.3.2 4 bidirectional counters 200KHz

CN14 Terminal Symbol Description Address

1A Output + 24V dc1)

2A PHA1 Phase A

Count 1
PNP / Push-Pull2)

2.INP17
2.CNT01

3A PHB1 Phase B 2.INP18

4A Z1 Z 1.INT01

5A 0V

Common for count inputs6A 0V

7A 0V

1B Output + 24V dc3)

2B PHA1+ + PHA

Count 1
Line Driver

2.INP17
2.CNT01

3B PHB1+ + PHB 2.INP18

4B Z1+ + Z 1.INT01

5B PHA1- - PHA

6B PHB1- - PHB

7B Z1- - Z

1), 3) Used to power the encoder. See Connection examples.
2) PNP/Push-Pull type count input configuration:
Terminal 5B: connect to terminal 5A
Terminal 6B: connect to terminal 6A
Terminal 7B: connect to terminal 7A

CN15 Terminal Symbol Description Address

1A Output + 24V dc1)

2A PHA2 Phase A

Count 2
PNP / Push-Pull2)

2.INP19
2.CNT02

3A PHB2 Phase B 2.INP20

4A Z2 Z 1.INT02

5A 0V

Common for count inputs6A 0V

7A 0V

1B Output + 24V dc3)

2B PHA2+ + PHA

Count 2
Line Driver

2.INP19
2.CNT02

3B PHB2+ + PHB 2.INP20

4B Z2+ + Z 1.INT02

5B PHA2- - PHA

6B PHB2- - PHB

7B Z2- - Z

1), 3) Used to power the encoder. See Connection examples.
2) PNP/Push-Pull type count input configuration:
Terminal 5B: connect to terminal 5A
Terminal 6B: connect to terminal 6A
Terminal 7B: connect to terminal 7A
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CN16 Terminal Symbol Description Address

1A Output + 24V dc1)

2A PHA3 Phase A

Count 3
PNP / Push-Pull2)

2.INP21
2.CNT03

3A PHB3 Phase B 2.INP22

4A Z3 Z 1.INT03 FREQ13)

5A 0V

Common for count inputs6A 0V

7A 0V

1B Output + 24V dc4)

2B PHA3+ + PHA

Count 3
Line Driver

2.INP21
2.CNT03

3B PHB3+ + PHB 2.INP22

4B Z3+ + Z 1.INT03 FREQ15)

5B PHA3- - PHA

6B PHB3- - PHB

7B Z3- - Z

1), 4) Used to power the encoder. See Connection examples.
2) PNP/Push-Pull type count input configuration:
Terminal 5B: connect to terminal 5A
Terminal 6B: connect to terminal 6A
Terminal 7B: connect to terminal 7A
3), 5) Can be used as frequency input for a FREQ device, indicating 1 in the device declaration

CN17 Terminal Symbol Description Address

1A Output + 24V dc1)

2A PHA4 Phase A

Count 4
PNP / Push-Pull2)

2.INP23
2.CNT04

3A PHB4 Phase B 2.INP24

4A Z4 Z 1.INT04 FREQ23)

5A 0V

Common for count inputs6A 0V

7A 0V

1B Output + 24V dc4)

2B PHA4+ + PHA

Count 4
Line Driver

2.INP23
2.CNT04

3B PHB4+ + PHB 2.INP24

4B Z4+ + Z 1.INT04 FREQ25)

5B PHA4- - PHA

6B PHB4- - PHB

7B Z4- - Z

1), 4) Used to power the encoder. See Connection examples.
2) PNP/Push-Pull type count input configuration:
Terminal 5B: connect to terminal 5A
Terminal 6B: connect to terminal 6A
Terminal 7B: connect to terminal 7A
3), 5) Can be used as frequency input for a FREQ device, indicating 2 in the device declaration
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3.3.3 2 SSI absolute counters

CN11 Terminal Symbol Description Address
1A

Internal bridge 1A-2A-1B-2B
2A
3A DATA1+

DATA in SSI1
1

4A DATA1-
5A CLOCK1+

CLOCK out SSI1
6A CLOCK1-
7A 0V Common for count inputs
1B

Internal bridge 1A-2A-1B-2B
2B
3B DATA2+

DATA in SSI2
2

4B DATA2-
5B CLOCK2+

CLOCK out SSI1
6B CLOCK2-
7B 0V Common for count inputs
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3.4 Analog inputs

3.4.1 2 multistandard analog inputs

Connector

CN13 Terminal Symbol
Description

AddressPotenziometers / 0-10V /
0-20mA Thermocouple PT100

1 AI2_C - TC 2 + C

2.AI022 AI2_B - TC 2 - B

3 AI2_A Analog input 2 - A 1)

4 AI1_C - TC 1 + C

2.AI015 AI1_B - TC 1 - B

6 AI1_A Analog input 1 - A 2)

7 VREF Reference voltage 3) - -

8 GAI Common - -

1), 2)  A and B cables are connected to the same head of the PT100 wire and have the same colors.
In the case of 2-wire PT100 make a jumper between A and B.
3) For potentiometers

Analog inputs setting

Num.
Dip

Analog input 1 Analog input 2
PT100 Thermocouple Pot. 0-10V 0-20mA PT100 Thermocouple Pot. 0-10V 0-20mA

SW5 1 ON X OFF OFF OFF X X X X X

2 OFF X ON ON ON X X X X X

3 X X X X X ON X OFF OFF OFF

4 X X X X X OFF X ON ON ON

5 ON ON OFF OFF OFF X X X X X

6 OFF OFF ON ON ON X X X X X

7 OFF ON X X X X X X X X

8 X X X X X OFF ON X X X

SW4 1 X X X X X X X OFF OFF ON

2 X X X X X X X OFF ON OFF

3 X X OFF OFF ON X X X X X

4 X X OFF ON OFF X X X X X

X = irrelevant setting
Pot. = potentiometric type input
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3.5 Digital outputs

3.5.1 16 protected outputs

CN9 Terminal Symbol Description Address

1 V+ Outputs power input O1÷O4 (12÷28V dc)

2 O1 Digital output 1 2.OUT01

3 O2 Digital output 2 2.OUT02

4 O3 Digital output 3 2.OUT03

5 O4 Digital output 4 2.OUT04

6 V+ Outputs power input O5÷O8(12÷28V dc)

7 O5 Digital output 5 2.OUT05

8 O6 Digital output 6 2.OUT06

9 O7 Digital output 7 2.OUT07

10 O8 Digital output 8 2.OUT08

11 V- Outputs power in (0V dc)

.

CN8 Terminal Symbol Description Address

1 V+ Outputs power input O9÷O12(12÷28V dc)

2 O9 Digital output 9 2.OUT09

3 O10 Digital output 10 2.OUT10

4 O11 Digital output 11 2.OUT11

5 O12 Digital output 12 2.OUT12

6 V+ Outputs power input O13÷O16(12÷28V dc)

7 O13 Digital output 13 2.OUT13

8 O14 Digital output 14 2.OUT14

9 O15 Digital output 15 2.OUT15

10 O16 Digital output 16 2.OUT16

11 V- Outputs power in (0V dc)

https://wiki.qem.it/lib/exe/detail.php/connettori/cnn_11fv_p3.5_01.png?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/connettori/cnn_11fv_p3.5_01.png?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
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3.5.2 2 STEP-DIRECTION outputs

Connector

CN10 Terminal Symbol Description Address
1A VD1 Internal bridge 1A -1B
2A DIR1+ Output DIRECTION 1

Push-Pull Line Driver
2.PULSE01

3A STEP1+ Output STEP 1
4A DIR2+ Output DIRECTION 2

2.PULSE02
5A STEP2+ Output STEP 2
6A 0V Common for stepper outputs
1B VD1 Internal bridge 1A -1B

2B DIR1- Complementary output
DIRECTION 1

Complementary outputs
for use in drives with
Line-Driver inputs

3B STEP1- Complementary output STEP 1

4B DIR2- Complementary output
DIRECTION 2

5B STEP2- Complementary output STEP 2
6B 0V Common for stepper outputs

Outputs STEP-DIRECTION voltage setting

By placing one of several jumpers JP5, JP6 and JP7, you can choose Nominal Operating Voltage of STEP and DIRECTION outputs.

Must be inserted only one jumper at a time
If you select one of the two voltage 5V (JP7) or 12V (JP5) terminals 1A and 1B must remain
disconnected

.

jumper
name Setting Nominal voltage

JP5 INSERTED

12V
(Voltage
supplied by
the
instrument)

JP6 INSERTED

VD1
(Voltage to
be supplied
to the
terminals
1A or 1B)

JP7 INSERTED
5V (Voltage
supplied by
the
instrument)

https://wiki.qem.it/lib/exe/fetch.php/strumenti/qmoveplus/j1p44/j1p44_stepper-set_02.png
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3.6 Analog outputs

3.6.1 4 analog outputs +/-10V, 16bit

CN12 Terminal Symbol Description Address

1 GAO Common for analog outputs

2 AO1 Analog output 1 2.AN01

3 AO2 Analog output 2 2.AN02

4 GAO Common for analog outputs

5 AO3 Analog output 3 2.AN03

6 AO4 Analog output 4 2.AN04
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4. Electrical features

The electrical features of the hardware are given below. Maximum and minimum frequency values and actual acquisition times, can still depend
on any additional software filters, see for example the system “QMOVE:sys004” variable on the section “QMOVE:sys004” on the section System
variables.

4.1 PROG PORT (USB mini-B)

Connector for IQ009 or IQ013

The USB mini-B connector does not support USB electrical standards, it can only be used
with an interface IQ009 or IQ013.

It is used for the transfer and debugging of the application program in the CPU.

Electrical standard TTL (Use serial interface IQ009 or IQ013)

Communication speed Min. 9.6 Kbaud - max 115200 Kbaud
settable by dip1 and 2 of the switch SW1

Insulation None

.

Connection between Qmove+ e PC using the accessory IQ009

.

Connection between Qmove+ and a device fitted with a RS232 serial port (e.g. a MODEM), using the interface IQ013

https://wiki.qem.it/doku.php/en/strumenti/accessori/iq009
https://wiki.qem.it/doku.php/en/strumenti/accessori/iq013
https://wiki.qem.it/doku.php/en/strumenti/accessori/iq009
https://wiki.qem.it/doku.php/en/strumenti/accessori/iq013
https://wiki.qem.it/doku.php/en/strumenti/accessori/iq009
https://wiki.qem.it/doku.php/en/strumenti/accessori/iq013
https://wiki.qem.it/lib/exe/detail.php/varie/strumqem_3d_01.png?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/cavi/cavo_iq009.png?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/varie/pc_01.png?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/doku.php/en/strumenti/accessori/iq009
https://wiki.qem.it/lib/exe/detail.php/varie/strumqem_3d_01.png?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/cavi/cavo_iq013.png?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/en/cavi/dispositivo_rs232.png?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/doku.php/en/strumenti/accessori/iq013
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4.2 RS232
Communication speed 4800, 9600, 19200, 38400, 57600, 115200 baud
Communication mode Full duplex
Operating mode Referred to 0V
Max. number of devices connected on the line 1
Max. cable length 15 m
Input impedence > 3 Kohm
Short-circuit current limit 7 mA

https://wiki.qem.it/lib/exe/detail.php/schemi/sch_rs232.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/cavi/cavo_rs232.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
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4.3 RS422
Communication speed 4800, 9600, 19200, 38400, 57600, 115200 baud
Communication mode Full duplex
Operating mode Differential
Max. number of devices connected on the line 1
Max. cable length 1200 m
Input impedence > 12 Kohm
Short-circuit current limit 35 mA

https://wiki.qem.it/lib/exe/detail.php/schemi/sch_rs422.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/cavi/cavo_rs422.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/fetch.php/cavi/cbl_userport-rs422_02.png
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4.4 RS485

To activate the internal termination resistance see paragraph Setup of USER PORT electric
standard, Setup of AUX1 PORT electric standard or Setup of AUX2 PORT polarization and
termination resistances

.

Communication speed 4800 baud (only if used with SERCOM and/or MODBUS device),
9600 baud, 19200 baud, 38400 baud, 57600 baud

Communication mode Half duplex
Operating mode Differential
Max. number of devices connected on the line 32
Max. cable length 1200 m
Input impedence > 12 Kohm
Short-circuit current limit 35 mA

https://wiki.qem.it/lib/exe/detail.php/schemi/sch_rs485.png?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/cavi/cavo_rs485.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
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4.5 CANbus

To activate the internal termination resistance see section Terminating resistors setting
CAN1 and CAN2 PORT

.

Comunication speed 125, 250, 500, 1000 Kbit/s
Maximum numr of Drivers/Receiver on the line 100

Maximum cable length 500m @ 125Kbit/s, 250m @ 250Kbit/s, 100m @ 500Kbit/s,
25m @ 1000Kbit/s

Input impedance >15Kohm
Short circuit current limit 45mA

On the first and last device, must be insert the termination resistance.
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4.6 ETHERNET

Ethernet Interface 10/100 Base T (IEEE 802.3) on RJ45 connector.

Connection between Qmove + and PC:

Qmove+ Cross-over cable EIA/TIA-568A/B PC

https://wiki.qem.it/lib/exe/detail.php/strumenti/qmoveplus/j1p72/j1p72_3d-culligan_01.png?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/cavi/rj-45_tia-568b_left.png?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/cavi/rj-45_tia-568a_right.png?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/varie/pc_01.png?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
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4.7 MMC/SD

Type of Memory
Card to use

MMC, SD and SDHC up to 8GB
For proper operation it is necessary that the device conforms to the standards set by “SD
Association” (www.sdcard.org) or “Multi Media Card Association” (www.mmca.org).

.

To use the Memory Cards they must first be formatted with FAT16 or FAT32 file system.

http://www.sdcard.org
http://www.mmca.org
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4.8 USB
Max output current 500mA
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4.9 Standard digital inputs
Type of polarisation PNP
Min. acquisition time (hardware) 3ms
Isolation 1000Vrms
Rated operating voltage 24Vdc
Voltage of logic state 0 0-2 V
Voltage of logic state 1 10.5 - 26.5 V
Internal voltage drop 5V
Input resistance (Ri) 2700Ω
Sink current 2mA ÷ 8mA1)

1) CAUTION: If the device connected to the inputs needs a higher minimum current, inputs may not work properly.
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4.10 Bidirectional counter inputs 200KHz

The values given in the table refer to input signals A, B and Z.
The max. frequency given in the table refers to A and B phase signals with a
DutyCycle = 50%
With count frequencies over 50KHz the use of Line-Driver type encoders is
recommended.

Type of polarisation PNP/PP
Max frequency 200KHz
Min. acquisition time 5µs
Insulation 1000Vrms
Rated operating voltage 24Vdc
Voltage of logic status 0 0 - 2 V
Voltage of logic status 1 10.5 - 26.5 V
Internal voltage drop 1.2V
Input resistance 3100Ω

Line-Driver

Type of polarisation Line-Driver
Max. frequency 200KHz
Min. acquisition time 5µs
Insulation 1000Vrms
Rated operating voltage (PHx+ ? PHx-) 5Vdc
Voltage of logic status 0 (PHx+ ? PHx-) 0-1.5 V
Voltage of logic status 1 (PHx+ ? PHx-) 2-5 V
Internal voltage drop 1.2V
Input restistance 150Ω
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4.11 SSI absolute counters
Frequency 320KHz
Operation mode Differential
Input impedance >= 12KO
Short circuit current limit >= 35mA



C1-R44-Fx BASE

40/77

4.12 Analog inputs

4.12.1 Conversion times

The electrical features depend on the type of input, configurable via DIP switch.

The conversion times from analog to digital depend on the configuration according to the table:

Analog Input Configuration Conversion time
per channelInput 1 Input 2

DC1) - 4.6 ms
- DC2) 4.6 ms

DC3) DC4) 9.3 ms
DC5) TC 9.3 ms
DC6) PT100 79.1 ms
TC - 9.3 ms
- TC 9.3 ms

TC DC7) 9.3 ms
TC TC 9.3 ms
TC PT100 83.8 ms

PT100 - 74.5 ms
- PT100 74.5 ms

PT100 DC8) 79.1 ms
PT100 TC 79.1 ms
PT100 PT100 79.1 ms

1), 2), 3), 4), 5), 6), 7), 8) Amperometric, voltmetric or potentiometric type

4.12.2 Amperometric input configuration 0-20mA

Connection type Amperometric
(0-20 mA)

Resolution 12bit/16bit1)

Input resistance 125Ω
Value of damage 25 mA
Max. Linearity error + 0,1% Vfs
Max. Offset error + 0,1% Vfs
S.n. 71 dB

Conversion time It depends on the configuration of the analog input.
See section Conversion times if present 2)

Isolation 1000 Vrms
1) It depends on the Hardware versions
2) The sampling time of the device must be equal or higher than the conversion time
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4.12.3 Potentiometric analog input configuration

Connection type Potentiometric 1KΩ÷20KΩ
Resolution 12bit/16bit1)

Reference voltage output 2,5Vdc
Max output current from reference 10mA
Input resistance 10MΩ
Max. Linearity error + 0,1% Vfs
Max. Offset error + 0,1% Vfs
S.n. 71 dB

Conversion time It depends on the configuration of the analog input.
See section Conversion times if present 2)

Isolation 1000 Vrms
1) It depend on the Hardware versions
2) The sampling time of the device must be equal or higher than the conversion time
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4.12.4 Voltmetric analog input configuration

Connection type Voltmetrico
0÷10V

Resolution 12bit/16bit1)

Input resistance (Rin) 40KΩ
Value of damage 20V
Max. Linearity error + 0,1% Vfs
Max. Offset error + 0,1% Vfs
S.n. 71 dB

Conversion time It depends on the configuration of the analog input.
See section Conversion times if present 2)

Isolation 1000 Vrms
1) It depends on the Hardware versions
2) The sampling time of the device must be equal or higher than the conversion time

https://wiki.qem.it/lib/exe/fetch.php/schemi/sch_in-voltmetrico_02.png
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4.12.5 PT100 analog inputs configuration

Sensor type
collegabile PT100 3 wire 1)

Measure type Resistance 2)

Resolution 15 bit (32767 corresponds to 250.00 O)
Input resistance (Rin) 15 MO
Measuring current 1 mA
Value of damage 10V
Accuracy of resistance measurement ± 0,04%

Conversion time It depends on the configuration of the analog input.
See section Conversion times if present 3)

Isolation 1000 Vrms
1) Also connected to 2-wire terminals with jumper
2) Temperature calculated by software
3) The sampling time of the device must be equal or higher than the conversion time
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4.12.6 Termocouple analog input configuration

Sensor type Thermocouple type J,K,R,S,B,N,T,E 1)

Type of measure Differential voltage
Resolution 16 bit
Measuring range ±156.25 mV
Measure for cold junction compensation Integrated
Input resistance (Rin) 15 MO
Value of damage 30V
Measurement accuracy ± 0,2% (excluding cold junction compensation)

Conversion time It depends on the configuration of the analog input.
See section Conversion times if present 2)

Isolation 1000 Vrms
1) J and K only supported by SW. Contact QEM for the support of the other sensor types.
2) The sampling time of the device must be equal or higher than the conversion time
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4.13 Protected digital outputs
Switchable load Dc (PNP)
Max. operating voltage 28V
Insulation 1000Vpp
Max. internal voltage drop 600mV
Max internal resistance @ON 90mΩ
Max. protection current 12A
Max. operating current 2A
Max. current @OFF 5µA
Max switching time from ON to OFF 270µs
Max switching time from OFF to ON 250µs
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4.14 Stepper outputs
Type of polarisation Push-Pull / Line-Driver
Max output frequency 200KHz
Insulation 1000Vpp
Max. operating current 20mA
Max. voltage 24Vdc1)

1) Selectable via jumpers: 5V e 12V supplied by the instrument, 24V supply from outside to the terminal VDx
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4.15 Analog outputs
Type of connection Common mode
Insulation 1000Vrms
Voltage range (minimum no load) -9.8V - +9.8V
Max. offset variation depending on temperature* +/- 5mV
Resolution 16bit
Max. current 1mA
Output variation depending on load 100 µV/mA
Output resistence 249Ω
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5. Connection examples

5.1 CANbus

On the first (1) and on the last (3) device of the chain, the termination resistances must be
inserted.
The cable shoes must be connected to ground by the fastons provided on the metal body.

.

To activate the internal termination resistance see paragraph Setup of CAN1 and CAN2 PORT
Termination resistances

Caution: close the DIP JP1 and JP2 and insert the terminating resistors (RL, RH) on the last
device in the chain.
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5.2 Digital inputs
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5.3 Line Driver counter inputs
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5.4 PNP / Push Pull counter inputs
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5.5 SSI absolute counters
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5.6 Analog inputs

5.6.1 Potentiometric input 1 and voltmetric input 2
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5.6.2 PT100 input 1 and amperometric input 2
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5.6.3 PT100 input 1 and termocouple input 2
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5.6.4 Termocouple inputs 1 and 2
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5.6.5 PT100 inputs 1 and 2
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5.7 Protected digital outputs
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5.8 STEP - DIRECTION outputs

Example with Push-Pull Output 1 and Line-Driver Output 2
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5.9 Analog outputs
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6. Settings, procedures and signals

6.1 Settings, procedures and signals
SW1 Dip DIP Settings Function

1
OFF Baud-rate 57600 PROG PORT

transmission speed
selectionON Baud-rate 115200

2
OFF Baud-rate 57600 USER PORT transmission

speed selectionON Baud-rate 115200

3
OFF Can also be used by SERCOM and MODBUS

device PROG PORT function
mode selection

ON Cannot be used by SERCOM and MODBUS
device

4 OFF ON OFF ON
Valid if in the CANOPEN
device declaration is set
the speed to 0 )]5

OFF OFF ON ON
Baud-rate
125KB/S

Baud-rate
250KB/S

Baud-rate
500KB/S

Baud-rate
1MB/S

6
OFF MMC/SD External media device

selection on the system
functionsON USB

7 Reserved. Leave OFF

8
OFF PROG PORT normal Select the USER PORT

as PROG PORT1)ON PROG PORT on the USER PORT connector
1) It's possible to use the connector of the USER PORT as PROG PORT with RS232 electric standard. The mini-USB PROG PORT connector is unplugged (USER PORT electric standard setting). For this function is necessary to set
at OFF the dip 6 of the SW2.

https://wiki.qem.it/lib/exe/fetch.php/strumenti/qmoveplus/j1p44/j1p44_settaggi_01.png
https://wiki.qem.it/lib/exe/detail.php/dip-switch/dip-8.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
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6.2 Led

The system leds “pow, run, stop, err” are found on the front panel and on the rear of controllers with display and only on the top of
controllers without display.

The user leds “L1, L2, L3 e L4” are found on the rear:

“System Leds” Signals

Leggend:

 Led ON

 Led OFF

 Led Blinking

Led Colour Status Description

pow Green
Power on

Only this led on, signals the CPU reset status

run Green
CPU in RUN status

CPU in READY status

stop Yellow With pow on, signals the STOP status of the CPU
With pow off, signals the BOOT status of the CPU

err Red With pow off, signals a hardware error. See paragraph Hardware Error codes
With pow blinking, the flash rate gives the type of error. See paragraph err led signals

https://wiki.qem.it/lib/exe/fetch.php/led/j1p44_led_sistema-front_01.png
https://wiki.qem.it/lib/exe/fetch.php/led/j1p44_led_utente-retro_01.png
https://wiki.qem.it/lib/exe/fetch.php/led/led_on.jpg
https://wiki.qem.it/lib/exe/fetch.php/led/led_off.jpg
https://wiki.qem.it/lib/exe/fetch.php/led/led_lamp.jpg
https://wiki.qem.it/lib/exe/detail.php/led/led_on.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/led/led_on.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/led/led_on.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/led/led_lamp.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/led/led_on.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/led/led_lamp.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
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Err led signals

N.
flashes Error Description Recommended action

1 Bus error Bus configuration different to
application software.

Check the correspondence between the QMOVE
application (BUS section of configuration unit) and the
product configurations (cards mounted in BUS).

2 CheckSum
Error

Negative outcome on the
integrity control of retentive
variables . (see Reset Error
Checksum)

Restore the machine data from a backup (.DAT file) or
cancel the error with in system functions and enter the
values manually.

3 Index Out of
Bound

An array index is pointing on
an inexistent element

Open a unit editor in Qview development environment
and use the “Edit→Go to PC” command to find the
program line that is cause of the error. In general the
index value has a value <1 or >array dimension.

4 Program Over
Range

The program selection index
in the DATAGROUP has
attempted to access an
inexistent program.

With the Qview development environment open the
editor of a unit and user the “Edit→Go to PC” command
to highlight the program line that has caused the error.
In general the value used as index is lower than 1 or
over the array dimension.

5 Step Over
Range

The step selection index in
the DATAGROUP has
attempted to access an
inexistent step.

With the Qview development environment open the
editor of a unit and user the “Edit→Go to PC” command
to highlight the program line that has caused the error.
In general the value used as index is lower than 1 or
over the array dimension.

6 Division By
Zero

The denominator of a division
operation of the application
program has a zero value.

With the Qview development environment open the
editor of a unit and user the “Edit→Go to PC” command
to highlight the program line that has caused the error.

7 Syntax Error The application program has
an invalid instruction

This error may appear because the program counter has
met the QCL END instruction.

8 Watch Dog
Error

A CAN module does not
function correctly, or a
specialist card has a
hardware problem

With the Qview development environment open the
“Monitor→Bus” panel and the righthand column called
“Watchdog Bus” indicates the card that caused the
problem.

9 Stack Error
The applciation program has
used all permitted levels of
calls to subroutines

With the Qview software environment open the editor of
a unit and use the “Edit→Go to PC” command to
highlight the program line that caused the error.
Analyse the unit execution flow, the call to subroutines
nestings have a limit, over which this error is generated.

Hardware error codes

During the startup sequence, if a malfunction of any peripheral is detected, the system blocks and the error is signaled by the flashing led 
err while the other system led's remain off.

The number of flashes indicates the type of error according to the following table :

Number of flashes Error
1 Display
2 FPGA
3 Media
4 Bootloader
5 FW
6 Bus
7 Signal not active
8 Signal not active
9 Exception

.

Each of these signals indicates a serious error situation. The product must be sent to the
QEM aftersales service.

https://wiki.qem.it/lib/exe/fetch.php/led/led_lamp.jpg
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“User Led” signal

Led Colour Description

 L1

Yellow Programmable in the application program by the QMOVE system variable:sys003 and used by the
system functions

 L2

 L3

 L4

https://wiki.qem.it/lib/exe/fetch.php/led/j1p44_led_utente-retro_01.png
https://wiki.qem.it/lib/exe/detail.php/led/led_on.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/led/led_on.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/led/led_on.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/led/led_on.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
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6.3 Keys

Name Description

FUNC
Press on startup of the controller to access the System functions

BOOT

Press on startup of the controller to set the CPU in Boot status and then access the firmware update
functions

RESET
Reset CPU. the system is restarted restoring the initial conditions (after a startup )

https://wiki.qem.it/lib/exe/fetch.php/pulsanti/j1p44_pulsanti_01.png
https://wiki.qem.it/lib/exe/detail.php/varie/pulsante_6x6.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/varie/pulsante_6x6.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
https://wiki.qem.it/lib/exe/detail.php/varie/pulsante_6x6.jpg?id=en%3Astrumenti%3Aqmoveplus%3Ac1r44%3Amimc1r44fx_base
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7. Operating Overview

7.1 Foreword

This chapter covers aspects and descriptions of the product functionalities that are often related to the firmware, which enable the
functionalities that enable its operation as a QEM Qmove+ programmable system.

7.2 Organizing data and memories

To best understand the terms used in this chapter, it is important to know the organisation of data and memory in a QMOVE application. QMOVE
applications are programs written in QCL language that, translated in binary code, are transferred onto QMOVE hardware and saved there. In
the hardware, the microprocessor runs has a program called firmware that interprets the above binary code instructions and performs the
operations associated to them.

A QCL application, in addition to the instructions, is also composed of variables that the QCL instructions act on.. Some of these variables are
retentive, i.e. their values remain unaltered from shut-off to start up. The flow chart below illustrates the organisation of data in a QCL
application transferred to the memory of any QMOVE hardware:

It can be noted that, the QMOVE hardware has several mass storage devices:

“Flash memory”, where the following is saved:

QCL program: the series of QCL instructions translated into binary by the compiler.
HMI program: the series of HMI screens translated into binary by the compiler. This program only exists when the
QMOVE hardware has a display.
Configuration data: the calibration and configuration data, the touch-screen calibration settings, the ethernet
communication configuration data (IP address, etc…), etc.

“Non volatile memory”, which stores:

Retentive variables: the group of variables that remains unaltered on a shut-off and startup (e.g. SYSTEM, ARRAYS,
DATAGROUP, etc).

“Volatile memory”, which stores:

Not retentive variables: the group of variables that is set to 0 at each startup (e.g. GLOBAL, ARRGBL, etc).

The volatile data memory is also used as dynamic memory. i.e. the memory used by the firmware for internal operations and active HMI screen
management.

“Mass storage internal device” is managed by a standard filesystem and is useful to save information by the DATASTORE device (read -
write binary or csv files with recipes, logs, variuous setups, etc).
It 'also used to store the backup of the application QMOVE and other service files.

“Mass storage external device” is managed by a standard filesystem and is useful for loading the QMOVE application, data loading/saving,
firmware update or to save informations by the DATASTORE device.

7.3 CPU states

The CPU has several operating statuses. The figure below shows the main status changes from the controller startup.
The main operating statuses are RESET, READY, RUN and STOP.
The CPU events that determine a transition from one status to another are mainly linked to commands being sent by the development
environment: Run, Reset, Stop and Restart.
Application download is the development environment procedure that allows to transfer a QMOVE application to the CPU.
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The BOOT state can be used to access the firmware updating functions.

During the startup, after scanning the system led's, the controller performs a series of self-diagnostic operations. When any faults are detected
or the operator has to be informed of any given situation, the self-doagnosis procedure is temporarily interrupted, signalling the event.
The fault signal is made by led's L1, L2 and a message is given on display (if present).

System Messages

n. Led ON System Message (if display
present) Description Type

1  L1 System Data WRITE ERROR Indicates that a write error has occurred during the
configuration data saving. B

2  L2
System Data IS RESTORED
FROM DEFAULT

Indicates that the configuration data has been restores to
the default settings. C

3  L1

 L2

System Data is updated
Please verify new data

Indicates that the configuration data has been converted
into a new format. Check that the previous settings have
been maintained.

C

4  L3
Firmware is updated
old: 1K31F10 1.001
new: 1K31F10 1.002

Indicates that a firmware update has been made. C

When the condition detected allows to continue to the start stage (type C) and waits for the FUNC button  or for the F1 key  to be
pressed to continue the boot procedure.

If not provided with a display, the controller waits 5 seconds before continuing with the startup stage, without waiting for a button to be
pressed.
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When the situation does not allow to continue the startup stage (tipo B), the controller, if provided with a display, shows the message“PLEASE
TURN OFF AND TURN ON THE SYSTEM” and remains in this state until you turn off. If the controller is not provided with a display, the led

 err flashes continuously.

The SYSTEM FUNCTIONS status can be used to access the SYSTEM FUNCTIONS, which are special procedures that allow the user to perform
various operations. For more details see the System Functions chapter.

Led status pow

run
Status cause No application in memory.
The condition that can put the CPU in this status RESET command.

This condition can only pass onto a READY status by downloading the applicaiton, using the Qview6 development environment.

Led status pow

run
Status cause Application valid and waiting for execution.
Conditions that can put the CPU in this status Application download.

This condition can pass onto to the RUN or RESET statuses.

Led status pow

run
Status cause Application in execution.
Condition that can put the CPU in this status RUN command.

This condition can pass onto all other CPU statuses.

Led status pow

stop » run
Status cause Stop on application in execution.
Condition that can put the CPU in this
status

A breakpoint has been encountered in the application code
interpretation.

This condition can pass onto all other CPU statuses.

7.4 System functions

IMPORTANT: The use of these procedures could represent a risk (e.g. deletion of
application), therefore it is highly recommended that they are performed by qualified
experts.

The system functions are speficic procedures that allow the user to perform various operations, e.g. the configuration/calibration of peripherals,
data and application save/restore on/from removable mass memory, deletion of the application and management of the mass memories.

All the system functions are listed below.
DEVICE indicates an external storage media. MMC / SD or USB for hardware that they have the port.

System Functions

n. Led ON System Functions Description

1 L1 01 - Reset Error Checksum
Reset checksum error.

NOTE: if the checksum error is present, the led  L1
flashes.

2 L2 02 - Copy all files DEVICE → NAND Copy all files from DEVICE to NAND Flash memory.

3 L1

L2
03 - Copy all files NAND → DEVICE Copy all files from NAND Flash memory to DEVICE.

4 L3 04 - Application delete Delete the application.

5 L1

L3
05 - Application upload from DEVICE Upload the application from DEVICE.

6 L2

L3
06 - System Settings Not implemented for this hardware
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n. Led ON System Functions Description

7
L1

L2

L3

07 - Downl. retentive data to DEVICE Save the retentive data on DEVICE.

8 L4 08 - Set NEW Password Not implemented for this hardware

9 L1

L4
09 - Remove all files from NAND Flash Cancel all files stored on the NAND Flash memory.

10 L2

L4
10 - Show NAND Flash files Not implemented for this hardware

11
L1

L2

L4

11 - Touch Calibration Not implemented for this hardware

12 L3

L4
12 - Set Ethernet communic. parameter Not implemented for this hardware

13
L1

L3

L4

13 - Backup to NAND Run the backup of the QCL application, data and HMI
application on NAND memory.

14
L2

L3

L4

14 - Restore from NAND Run the restore of the QCL application, data and HMI
application from NAND memory.

15

L1

L2

L3

L4

15 - Firmware Upgrade Run the firmware upgrade from DEVICE.
Available only in some hardware.

Note: To exit system functions press the keep the FUNC button for at least two seconds.

7.4.1 Access to system functions

To access the System Functions, start up the controller with FUNC button pressed.

The QMOVE application, if present, it not executed and the led L1 lights up.

Use FUNC button to scroll through the functions.
The selected function is indicated by the combination of L1-L2-L3-L4 leds lighted up.

The “System Functions” table gives the list of system functions and related led combinations.

Press BOOT button for 2 seconds to execute the selected function.
The POW led starts flashing to indicate that the selected function is being executed.

When the function ends the POW led stops flashing.

Press FUNC button to restart the controller.

If the function does not complete properly the POW stops and the ERR starts flashing.

The number of flashes indicates the type of error as shown in the table System Function Error Messages.

When a system function ends with an error, the number of led flashes  err indicates the type of error.
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If there is a display, a message is given to describe the cause of the error.

System Function Error Messages

Error/Number of ERR led flashes Message
1 Generic error
2 Open/Exist/Create file error
3 Read file error
4 Write file error
5 Out of Memory error
6 QMos Version error
7 Checksum Error
8 Symbols checksum No Match
9 Configuration / Symbols error
10 File format error
11 Format error
12 Device not present or unformatted
13 Application not present error
14 Touch calibration failure
15 File compression type not support
16 Target don't match project !
17 Fw version don't match project !
18 File copy error
19 File size error
20 Crypt operation error
21 Invalid Product Serial Number
22 Function is locked
23 Function not enabled

7.4.2 Description of the functions

The system runs an integrity control of retentive variables by the applicaiton of a CRC to the nonvolatile data memory. This detects any

corruption and prevents the application from starting up, signalling the situation by flashing the led  err as shown in Err led signals.
For the application to function again, a new download of the application must be performed with the development environment, or the “Reset
Error Checksum” system function. These operations delete the error status and zero-setsall retentive variables.

The procedure:

Check the error status and end the funciton if no error is present.
In microQMove products, the presence of the QCL application is also checked.
Vengono azzerati i dati ritentivi e viene visualizzato il messaggio “Clear power down data…” fino al termine della
procedura.
Resets the retentive data and the message “Clear power down data…” until the end of the procedure.
End of operation

This procedure copies all files in the root and “DS” directory of the external MMC/SD or USB card to the NAND internal mass storage.

The following table gives the sequence of operations and any possible errors:

Message Description Possible errors

Check DEVICE presence

Checking for the presence of the external
mass storage card
On DEVICE appears MMC or USB,
depending on what is selected

Device not present or
unformatted

Mounting device… Mounting the external mass storage card Device not present or
unformatted

Searching files… Searching for compatible files No Files Found
Copy <filename>…. Making a copy of the files indicating the name currently in copy

This procedure copies all files contained in the root and “DS” directory of the NAND internal mass storage to the external MMC/SD or USB card
memory.

The following table gives the sequence of operations and any possible errors:

Message Description Possible errors

Check DEVICE presence

Checking for the presence of the external
mass storage card
On DEVICE appears MMC or USB,
depending on what is selected

Device not present or
unformatted

Mounting device… Mounting external mass storage device Device not present or
unformatted

Searching files… Searching for compatible files No Files Found
Copy <filename>…. Copying the files indicating the name of the one currently in copy

This deletes the application and empties the nonvolatible data memory, deleting the QCL program and, if present, deleting the HMI program.
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The following table gives the sequence of operations performed and any possible errors:

Message Description Possible errors
Reset retentive data Empty nonvolatible data memory Write file error
Delete QCL application Deletion of the QCL program Write file error
Delete HMI application Delection of the HMI program (if display installed) Write file error

This loads an application from the external MMC/SD or USB mass memory card to the non volatile memory.

This allows to load all or one of the QCL program, HMI program and retentive data.

The external MMC/SD or USB mass memory card must contain at least one of the following files:

applic.bin for the compiled QCL program generated by the Qview development environment
applic.dat for the data file generated by the “Save Data…” procedure of the Qview development environment or by
the Downl system function. for retentive data to DEVICE;
appqtp.bin for the compiled HMI program generated by the Qpaint development environment; it is generated by the
special function “Download the project to File…”.

Message Description Possible errors

Check DEVICE
presence

Checking for the presence of the external
mass storage card
On DEVICE appears MMC or USB,
depending on what is selected

Device not present or
unformatted

Mounting device… Mounting external mass storage card Device not present or
unformatted

If the applic.bin is present:

Message Description Possible errors

Upload QCL application Uploading the QCL program

Open/Exist/Create file error
Write file error
Read file error
Out of Memory Error
QMos Version Error
Checksum Error
Symbols checksum No Match
Configuration / Symbols Error

If the applic.bin file is not present, an application must already be loaded in the nonvolatile memory otherwise the “Application not present”
message is given.

If the applic.dat file is present:

Message Description Possible errors

Upload retentive data Uploading retentive data to the nonvolatile
data memory

Open/Exist/Create file error
Write file error
Read file error
Out of Memory Error
QMos Version Error
Checksum Error
Symbols checksum No Match
Configuration / Symbols Error
QTP File format error

The procedure performs the following steps:

Check the presence of the MMC/SD or USB card.
The “Check DEVICE presence” message is given.
On DEVICE appears MMC or USB, depending on what is selected.
Mounting MMC/SD or USB card.\\The “Mounting device…” message is given.
Uploading the QCL program (applic.bin), if contained in the removable mass storage device
The “Upload QCL application” message is given.
Uploading retentive data of the QCL program (applic.dat), if contained in the removable mass storage device
The “Upload retentive data” message is given.
NOTE: if the applic.dat file is not found, the data in the system is maintained so long as the Symbol and
Configuration checksums have not been varied. If they are varied all data will be set to zero.
Uploading the HMI program (appqtp.bin), if contained in the removable mass storage device
The “Upload HMI application” message is given.
The file is closed and the operation ends.

This function creates a file on external mass storage (MMD/SD or USB) containing the retentive data values.
The file created is named “applic.dat” and is the same as the file obtained by the “Save Data…” procedure in the QView development
environment. The function can only be performed if there is a valid QCL application in the controller.

The procedure performs the following steps:

Check the presence of the MMC/SD or USB card.
The “Check DEVICE presence” message is given.
On DEVICE appears MMC or USB, depending on what is selected.
Mounting the MMC/SD or USB card.
The “Mounting device…” message is given.
Check the presence of the QCL program
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The “Checking application presence…” message is given.
Check the validity of the retentive data
The “Checking retentive data…” message is given.
Open the applic.dat destination file on the external MMC/SD or USB card
The “Open destination file…” message is given.
Write the headers in the destination file
The “Write headers to destination file” message is given.
Write the retentive data in the destination file
The “Write data to destination file”.
NOTE: the percentage progress of the operation is given during this step
Close the file and end the operation

Delete all files contained on the internal NAND flash mass storage.
Unlike the “Format NAND Flash” function, this acts at a filesystem level aqnd can therefore be performed as many times as necessary.

The procedure performs the following steps:

Calculation of the number of files contained in the internal mass storage.
The “Searching files…” message is given.
If zero files are found, the “No Files Found” message is given and the function ends, otherwise the “Delete
<filename>” is given indicating the delection of every file found.
Close the internal storage and end procedure

The backup procedure creates a copy of the QCL application in execution and a dump of the retentive data, as files saved in the NAND mass
storage. The files created have the following names:

applic.qcy identifies the file containing the QCL application (CPU)
appdat.qcy identifies the file containing the retentive data of the QCL application

The procedure performs the following steps:

Check the presence of the QCL application.
Create and write in NAND the QCL application backup file: applic.qcy.
Check the presence and validity of retentive data of the QCL application.
Create and write in NAND the retentive data backup file of the QCL application: appdat.qcy.
Procedure end and system reboot.

The restore procedure allows to recover from the NAND mass storage, the saved backup files of the QCL application and an dump of the
retentive data.

The procedure :

The NAND backup file of the QCL Application is read: applic.qcy.
The NAND backup file of the QCL Application retentive data is read : appdat.qcy.
Procedure end and system reboot.

Upgrade the firmware of the instrument through the external storage device MMC/SD or USB.

In the external storage device MMC / SD or USB must be present the following file:

firmware.a21

The procedure performs the following steps:

Check the presence of the MMC / SD or USB.
Firmware Update.
Closing the file and end operation.
Automatic restart of the instrument.

The use of system functions Backup to NAND and Restore from NAND allows to save in backup and restore a QMOVE application.

The backup and restore operations use the NAND internal memory device. The backup procedure creates a file copy of the QCL program, the
HMI program (if the controller has a Qem display) and an image of the ritentive data.

The files created:

applic.qcy containing the QCL program (QCL App)
appdat.qcy containing the ritentive data image (QCL Dat)
appqtp.qcy containing the HMI program (QTP App)

The files are encrypted and only the controller that generated them can run the Restore procedure so as to safeguard unauthorised data copies.
The backup file copied to external memory such as MMC/SD or USB card can be carried out with the system function Copy all NAND files ->
DEVICE. A directory named “QBK” is created in the MMC/SD or USB that contains the above files. In the same way backup files can be
transferred to the controller using the system function Copy all files DEVICE -> NAND. In this case, the files in the MMC/SD or USB must always
be contained in the directory “QBK”.

Backup/restore is an important function that can be used in the following cases:

to restore the QMOVE application to a known situation (the situation at the time of the backup), if data has been1.
changed by an operator or if the machine data has been altered for any reason.
when testing a new application, a backup can be made of the original, stable version. If the new application being2.
tested is not satisfactory, the restore command will recover the original version.

7.5 Information for programming

In this chapter are collected all the product information for programming.
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7.5.1 Development suite

The product programming requires the Qview-6 environments to program the QCL code and if the product has a graphic display, also the
QPaint-6 environment to design the screen graphics. Noth these softwares are available in the Qworkbench software package that can be
downloaded as freeware from the Qem website (in “Support” section).

The contoller has 3 slots. The slots 4 to 32 can be declared and must be used to address recources installed in the Canopen modules.

To use the terminal in a product that has a display, you must declare under INTDEVICE the device MMIQ2.

INTDEVICE
   Hmi  MMIQ2    2

To program with the QPaint-6 development environment it is important to select the correct target. To do so, in the environment select Project
→ Target Configuration then select the right controller according to the ordering code.

Example of a statement of the BUS to use on the BUS unit's configuration:

BUS
   1   1R44F    10
   2   1QM4F    .

The firmware versione must coincide, and if available, the specialization card name to the 3 slot must be correct. See the dedicate section.

Memories used

This paragraph looks at how to measure an estimate of use of the product's memories. The non volatile memory is available to memorise the
QCL program and has a capacity of 1MB.
The memory space occupied is equal to the size of the .BIN file generated by Qview. The percentage memory occupied can be viewed in the
CPU panel of Qview under “Used CODE memory”, or this information can be obtained from the value of parameter “sizeapp” of the QMOS
device.

The non volatile data memory used to memorise retentive variables, has a capacity of 819KB.
The percentage memory occupied can be viewed in the CPU panel of Qview, under “Used RETENTIVE”, or this information can be obtained from
the value of parameter “sizeret” of the QMOS device.

The volatile data memory used to memorise non ritentive variables has a capacity that depends on various factors.

7.5.2 Communication ports

The PROG and USER serial ports implement the QEM proprietary communication protocol called BIN1.

The SERCOM and MODBUS devices can be used with all communication serial ports including PROG PORT. Use the following number settings
during the device declaration to select the communication channel:

  0     PROG PORT
  1     USER PORT
  2     AUX1 PORT
  3     AUX2 PORT    (if available for this hardware)

When the SERCOM and MODBUS devices use the PROG PORT or USER PORT, they address the channel only if the communication status of the
device is open (st_opencom = 1). When the channel of the device is closed (st_opencom = 0) in the serial, the BIN1 protocol returns active. To
force the BIN1 protocol on the PROG port (thereby preventing the SERCOM device from occupying the channel) active the SW1 dip 3.

When using the MODBUS RTU protocol on serial port AUX2 (if available in the hardware) with RS485 electric configuration, remember that when
the serial port is transmitting, the controller maintains the channel (DE) active for a longer time than the “MODBUS RTU” specification. To this
must be consider a minimum time of 5 milliseconds after which it is possible to receive a new message. Also the SERCOM device, when it ends a
transmission, has the same time the channel is active (DE).

The Ethernet communication port use the transport protocol TCP/IP, where the BIN1 protocol packets are encapsulated within TCP/IP data
packets. There are two active connections identified by two communication ports can be freely set in the communication parameters of the
Ethernet port. If the instrument is provided with a display, these values are displayed and modified using the system function 12 - Set Ethernet
communic. parameter. Other ways to view and set these figures can be realized through special programs available within the development
environment (QConfigurator-1 and QConfigurator-2).

The port set in “Port nr.1:” represents a communication channel equivalent to PROG PORT. The port set in “Port nr.2:” represents a channel
equivalente to USER PORT. The ports 3 e 4 are not used.
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The Ethernet port can also be used to establish a communication type Modbus TCP/IP with other networked devices. In this case the channel
that identifies the Ethernet port can be set by entering the number 43.

mdbs   MODBUS   2   43

The 3 channels of Ethernet communication port (two with BIN protocol and one MODBUS TCP/IP) can be active simultaneously.

7.5.3 Firmware message error

When downloading the Qmove application, the QView-6 development environment can give error messages that are not described in the
development environment manual. These errors are special and the description string given by QView-6 is generated directly by the firmware.

The table below describes possible error messages generated by the firmware.

Firmware error messages

Possible error message Description
Error: SYSTEM + ARRSYS + DATAGROUP +
INTDEVICE size overflow by 234bytes.

Given when the retentive variables exceed the maximum
limit.

Error: serial port not avaliable in SERCOM
or MODBUS device declaration.

Given when the wrong number is used during the device
declaration to select the communication channel.

Error: CANOPEN device required if you use
more than 3 slots.

In the BUS definition more than 3 slots are being used and
so the application requests the use of Canopen modules.
To manage this, a CANOPEN device must be declared.

Error: incorrect bus fault mode in CANOPEN
declaration.

The CANOPEN device declaration indicates a fault mode
(last value in the declaration) that is not supported.

Error: incorrect canbus speed in CANOPEN
declaration.

The CANOPEN device declaration indicates an invalid
speed.

Error: too much CANOPEN device
declaration. Only one CANOPEN device can be declared.

Error: absol. encoder resource num in
ABSCNT device declar. is not avail.

The ABSCNT device declaration indicates an inexistent
resource.

Error: COUNT in ABSCNT device declaration
is not a simulated counter.

The counter address used in the ABSCNT device
declaration cannot be a simulated type (e.g. 1.CNT01).

QMos version error. Unsupported
instructions set.

One or more statements in the project QCL are not
supported by the firmware.

Error: compression file type not support. The compression of the compiled QCL program is not
supported by the firmware.

Error: too mutch slots in bus
declarations.

They were declared under BUS more slots than those
allowed by the hardware.

L'ambiente di sviluppo mette a disposizione una serie di variabili predefinite che possono essere utilizzate precedendo al nome la parola chiave
“QMOVE.”. Per esempio “QMOVE.is_suspend”, “QMOVE.sys001”, ecc. Lo scopo del presente paragrafo è illustrare le 16 variabili di sistema
chiamate sys001÷sys016 il cui significato dipende dal firmware che si sta utilizzando.

sys001

Questa variabile a sola lettura indica lo stato dei pulsanti FUNC (bit 0) e BOOT (bit 1). I valori possibili sono dunque:
0 = nessun pulsante premuto.
1 = pulsante FUNC premuto.
2 = pulsante BOOT premuto.
3 = pulsanti FUNC e BOOT premuti.

sys002

Questa variabile permette la lettura dell'immagine del dip-switch SW1. L'immagine viene acquisita solo all'accensione del prodotto. Il bit 0
corrisponde al dip 1 e così via.

NB: Alcuni dip non sono collegati al microprocessore e quindi viene letto sempre al livello logico 0.

sys003

Questa variabile permette il comando del led L1-L2-L3-L4. Il bit 0 corrisponde a L1, il bit1 a L2 e così via.

sys004

Questa variabile permette l'impostazione del filtro anti-glitch ai segnali delle fasi nei contatori bidirezionali. Il valore è espresso in KHz e si
riferisce alla frequenza del segnale di una fase. Il range di valori ammesso è 30÷220. Il valore impostato di default é 220KHz. La variabile può
essere anche riletta. La modifica del filtro può essere fatta in qualsiasi momento.

sys005÷16

Non utilizzata.

7.5.4 The devices

The device term identifies a category of software capable of supporting and monitoring activities, more or less complex, to solve the automation
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systems problems.
The list of implemented devices in the firmware depends from the firmware version.

The firmware version 10 include following device:

Device name Minimum sampling
time (msec)

Maximum sampling
time (msec) Execution time (%)

ABSCNT 1 250 8,31
ANINP 1 250 14,25
CALENDAR - - 0
CANOPEN 1 250 100
COUNTER3 1 250 5,94
DAC - - 0
DATASTORE 1 20 8,31
FREQ 1 250 4,75
MODBUS 1 250 32,07
QMOS - - 0
RECDATA 1 250 5,34
SERCOM 1 250 9,26

The firmware version 20 include also following device:

Device name Minimum sampling
time (msec)

Maximum sampling
time (msec) Execution time (%)

ANPOS2 1 250 8,31
EANPOS 1 250 55,94
HEAD2 1 250 23,75
OOPOS3 1 250 27,91

The firmware version 30 include also following device:

Device name Minimum sampling
time (msec)

Maximum sampling
time (msec) Execution time (%)

CAMMING3 1 250 55,94
INTERP 1 250 35,63

7.5.4.1 Features of the device

This section describes the additional information of the devices. This information complement and complete the maintenance manual of the
device available on the Qem site. These are the information related to the implementation of the devices in this product.

7.5.4.1.1 CANOPEN

If in the device declaration CANOPEN viene indicata la velocità zero allora essa diventa impostabile tramite dip di SW1.
The first slot of the target resources that reside within the Canopen is the 4.
The firmware capture the input interrupt while this is located in a Canopen module.
You can enter the 2 value in the Declaration of the device on the relative sector to the port. This setting makes it possible for the startup of the
QCL DS402 drives through a request (QDO number 10). This function is essential in cases where there are driver without enable input and the
power supply logical is in common with main power supply. If the main power supply is turn off, the drive ot communicating in CANOPEN
because also the logic section are turned off.

7.5.4.1.2 DATASTORE

The files used from the device DATASTORE are contain in the /DS folder. If this folder does not exist it is created automatically.
The DATASTORE device can can operate with MMC/SD or USB NAND memory inside the product (not removable). To define how your device
used the parameter value priority (0=MMC/SD, 1=NAND, 2=USB). If your application needs to frequently access to the MMC/SD or USB device
and do not require physical removal, you can use a particular priority parameter setting that avoids continually MOUNT UMOUNT devices.
Before execute the UMOUNT command to set the “priority = -1”.

A QCL code example to change device may be:

SUB SETMMC
  WAIT NOT data.st_busy
  IF data.st_mount
    data.priority = -1
    data.UMOUNT
    WAIT NOT data.st_mount
    CALL CHECK_ERR_WRN
  ENDIF
  data.priority = 0
  data.MOUNT
  WAIT data.st_mount
ENDSUB
 
SUB SETNAND
  WAIT NOT data.st_busy
  IF data.st_mount
    data.priority = -1
    data.UMOUNT
    WAIT NOT data.st_mount
    CALL CHECK_ERR_WRN
  ENDIF
  data.priority = 1
  data.MOUNT
  WAIT data.st_mount
  CALL CHECK_ERR_WRN
ENDSUB

Check for the existence of a file on the external memory. Do you use the “filenum” set to the -1 value and use the OPENFILE command. If you
set again the -1 value in “filenum” and use the OPENFILE command will search for the name of the next file, and so on. Whenever we will use a
different -1 value with OPENFILE the search loop filenum will be closes. When the search is complete and there will be no more files, then the
device will response to the OPENFILE command “filenum = -2”. The successful execution of the command will be indicated by flag st_busy = 0.
If the file extension is not HEX or CSV file itself is ignored by the search. In the case that the file name is not compatible with those managed by

https://wiki.qem.it/doku.php/en/software/devices/abscnt
https://wiki.qem.it/doku.php/en/software/devices/aninp
https://wiki.qem.it/doku.php/en/software/devices/calendar
https://wiki.qem.it/doku.php/en/software/devices/canopen
https://wiki.qem.it/doku.php/en/software/devices/counter3
https://wiki.qem.it/doku.php/en/software/devices/dac
https://wiki.qem.it/doku.php/en/software/devices/datastore
https://wiki.qem.it/doku.php/en/software/devices/freq
https://wiki.qem.it/doku.php/en/software/devices/modbus
https://wiki.qem.it/doku.php/en/software/devices/qmos
https://wiki.qem.it/doku.php/en/software/devices/recdata
https://wiki.qem.it/doku.php/en/software/devices/sercom
https://wiki.qem.it/doku.php/en/software/devices/anpos2
https://wiki.qem.it/doku.php/en/software/devices/eanpos
https://wiki.qem.it/doku.php/en/software/devices/head2
https://wiki.qem.it/doku.php/en/software/devices/oopos3
https://wiki.qem.it/doku.php/en/software/devices/camming3
https://wiki.qem.it/doku.php/en/software/devices/interp
https://wiki.qem.it/doku.php/en/software/devices/canopen
https://wiki.qem.it/doku.php/en/software/devices/datastore
https://wiki.qem.it/doku.php/en/software/devices/datastore
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DATASTORE (numbers from 0 to 9999999) then the “filenum” will remain set to -1 value and will report a warning.

The “disksize” and “diskfree” parameters are represented in KB.

7.5.4.1.3 RECDATA

The device can store 10000 step maximum.

7.5.4.1.4 QMOS

The “frwuvalue01” parameter contains the numeric value of the serial number of the product.
The “frwuvalue02” parameter contains the numeric value of the PN (Part Number).
The “frwuvalue03” parameter contains the numeric value of the hardware release.
The “frwuvalue04” parameter contains the numeric value of the VN (Vedi Nota).
The “frwuvalue05” parameter contains the numeric values of the QCL Level.

7.5.4.1.5 FREQ

To define the input associated to the device FREQ use the appropriate numeric field on the device. The availability of frequency inputs must be
verified with the hardware version of the product. To derive the relationship between numerical value and terminal pin use the information in
the “address” column in the tables in the illustration of the terminal.

7.5.4.1.6 CAMMING3

The parameters in the fields sector (CodeQm, CodeQs…) are not ritentive. At power-up they take always value 0.

https://wiki.qem.it/doku.php/en/software/devices/freq
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8. Available accessories
IQ009
IQ013
IQ011
IQ016
Connectors polarization Kit
Front panel customization kit

Documento generato automaticamente da Qem Wiki - https://wiki.qem.it/
Il contenuto wiki è costantemente aggiornato dal team di sviluppo, è quindi possibile che la versione online contenga informazioni più recenti
di questo documento.

https://wiki.qem.it/doku.php/en/strumenti/accessori/iq009
https://wiki.qem.it/doku.php/en/strumenti/accessori/iq013
https://wiki.qem.it/doku.php/en/strumenti/accessori/iq011
https://wiki.qem.it/doku.php/en/strumenti/accessori/iq016
https://wiki.qem.it/doku.php/en/strumenti/accessori/kit_polarizzazione_connettori
https://wiki.qem.it/doku.php/en/strumenti/accessori/kit_personalizzazione_pannello
https://wiki.qem.it/
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